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The LICA Creed 

 

Land, the foundation of the Nation 

The basis of all wealth 

The heritage of the wise 

The thrifty and prudent 

The poor man’s joy and comfort 

The producer of food, fiber and fuel 

The basis of factories 

The foundation of banks 
 

All that man builds is from the land. We often take it for 
granted or even abuse it; And yet many, unthinkingly 
and unknowingly pass the land by. What man does with 
the land will be the deciding factor of his survival. 

 Hello from southern Illinois, many of 

us are dodging showers and storms. Since 

our last newsletter we continue to meet 

with Illinois Corn Growers and Wetlands 

Initiative representatives about possible 

construction and demonstration projects. 

The latest on the Wetland project is that 

the soil profile in the location of the wet-

land is already wet subsurface. This will require a little different 

approach to construction than the last project. The ILICA show 

committee chair and his team are ready for the challenge and if 

this project can be completed we will get it done. Investigations 

and proposals for the Corn Growers have been prepared on 

three possible farms and have been presented for their consider-

ation. At the May Regular meeting the board agreed to continue 

discussions with Illinois Farm Bureau’s Lauren Lurkins about 

possible demonstration projects during 2017. Ryan and I have 

attended several NLRS benchmarking committee meetings. Eve-

ryone is seeking data about BMPs to reduce the Nutrient losses. 

The new ILICA Directory is now out, take a look and now 

would be a good time for me to Thank all of the Associates for 

supporting ILICA. Thank You to all the advertisers. 

 Bill Dean is planning a great Golf Outing June 24th and 

the Summer Picnic June 25th.  Come join in some fun and the 

summer annual meeting at which we plan to vote on some by-

laws changes. All of this information is available on the ILICA 

webpage. 

 National Summer Annual meeting agenda and venue have 

been announced. Kansas City area tours of interest, a full day of 

education sessions and the Board meeting. 

 The education committee and Ryan have been working on 

the August Drainage workshop. They have a proposed, three 

day agenda including tile drainage design & updates, edge of 

field BMPs, certification review & testing, and updates and de-

velopments in the technology available for use in construction. 

The Drainage workshop is scheduled for the first week of Au-

gust. 

Tom Beyers, President 

 P R E S I D E N T ’ S  M E S S A G E  



 

 

 

2016 Board & Member  

Meeting Schedule 
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N E W  M E M B E R S  

Active Contractors 

Steve Bumeter 

Peoria Lawn Maintenance Team, LLC 

522 Shady Oaks 

Metamora, IL 61548 

Ph: 309-712-2218 

Email: steveb@mtco.com 
 

Dave & Melinda Pellegrini 

D & M Landscaping 

100 W 7th Street 

Spring Valley, IL 61362-1431 

Ph: 815-664-2571 

A = absent                      P = present                  C = cancelled meeting 

Area / Director Jan Mar May Jun Sep Nov 

Pres: Tom Beyers P P P P   

VP: Lee Bunting P A P P   

1st VP: Grant Curtis P P P P   

Area 1 - Brian Brooks P P P  P      

Area 2 - Steve Anderson P P P P      

Area 2 - Stuart Anderson P P P P     

Area 3 - Mike Yordy P A A  A      

Area 3 - Joe Streitmatter P P P P      

Area 4 - David Kennedy P P A  P      

Area 4 - John McCoy P A P  P      

Area 5 - Vacant             

Area 6 - Jon Seevers P P P P      

Area 7 - Vacant             

Area 8 - Norm Kocher P A P P      

Associate Dir: Brad Baker P P A A   

2016 Board Member Meeting Attendance 

Unless changed by the Board during the year, the ILICA 
business meetings are scheduled as follows: 

 

 

September 10, 2016 - Regular Meeting of the Board: TBD 
 

November 5, 2016 - Regular Meeting of the Board: TBD 
 

January 13, 2017 - Winter Convention and Member Mtg.:               

       Meeting, Embassy Suites, East Peoria 
 

Exact location, committee meeting time & other details 
will be published in the ILICA News and sent to members 
via mail and/or email.  

Associate Members 

Dakota Street Insurance, LLC  

Shelly Samolinski 

120 E. Dakota St., PO Box 202 

Spring Valley, IL 61362 

Ph:  815-663-9905 

Email: info@dakotains.com 
 

Dimond Bros. Insurance, LLC  

Mark Trainor 

118 N. Third St., PO Box 47 

Fairbury, IL 61739 

Ph:  815-692-2343 

Email: mark.trainor@dimondbros.com 
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 Many have been keeping a close eye on a lawsuit in Iowa 

that was filed in March of 2015 involving 10 drainage districts 

that are being sued by the Des Moines Water Works (DMWW) 

for nutrient runoff.  This suit could have far reaching effects to 

farmers throughout the United States.  Des Moines Water 

Works is pointing the finger at drainage tile and drainage ditch-

es and accuses them of being “point sources which transport a 

high concentration of nitrates contained in groundwater.”  The 

trial was originally slated to begin on August 8, 2016 but was 

rescheduled last month by the U.S. District Court for the 

Northern District of Iowa in Sioux City.  The court has now 

given both parties until June 21, 2017 to reach a settlement or 

the case will go to trial on June 26, 2017.  Bill Stowe, DMWW 

CEO and General Manager since August of 2012, has been 

asked repeatedly what it would take for DMWW to drop their 

lawsuit against the districts.  In response, Stowe stated “We 

believe permitting the drainage districts is the clearest line to 

reducing pollutants in the Des Moines and Raccoon rivers.”  

However, Stowe has also admitted during deposition that be-

cause discharges from farm tiles are exempt from federal law, 

the drainage districts do not have the ability to require a permit 

 Norm & Coretha Rozendaal                 (800) 932-7611 

2064 Republic Ave West, Monroe IA 50170         (641) 259-2651 

        www.precisionintakes.com                Fax (641) 259-3218 

from farmers and others who discharge into the district.  John 

Torbert, Executive Director of the Iowa 

Drainage District Association 

equated the lawsuit 

to “suing the 

highway because cars travel the highway and cause 

pollution.”  This is a great analogy because the drainage dis-

tricts not the ones putting the water in the ditches, they are 

simply a way for the water to move from the area. 

 The Iowa Drainage Districts sought a motion for sum-

mary judgement and in that motion stated “DMWW asks this 

court to ignore drainage districts’ lack of ability to do anything 

DMWW requests, ignore congressional intent, overturn more 

than 40 years of consistent interpretation by the agencies re-

sponsible for administering the relevant statutes that Congress 

never overturned, and impose permitting requirements for 

drainage districts.”  The districts also pointed out that 

“Congress chose to place the burden to clean river water on 

drinking water utilities wishing to use river water, not those 

who convey nitrate to rivers.”  Iowa does have a Nutrient Re-

duction Strategy that has been in place for longer than the Illi-

nois Nutrient Loss Reduction Strategy.   

 In addition to the far reaching effects that this lawsuit can 

potentially have, it also places a significant financial burden on 

the Iowa districts in the form of legal fees.  Reportedly, the 

counties have raised $100,000 to pay local attorneys and there 

are three other entities that are raising funds.  One is a fund 

established by the Iowa Drainage District Association that had 

raised $153,250 with approximately $63,250 coming from the 

private sector.  There are also funds established in Sac County 

and Des Moines for local donations.  Joel Brinkmeyer, the 

CEO of the Agribusiness Association of Iowa stated “It’s a 

very expensive lawsuit for agriculture, not just the dollars, but 

the time and resources that agriculture is spending to defend 

their position.”  The lawsuit is costly for DMWW as well.  

They reportedly spent $550,000 and the case has not even 

gone to trial.  The IADD will keep a close watch on this law-

suit  since it will likely have far reaching effects. 

DE S  M O I N E S  W A T E R  WO R K S  C A S E  D E L A Y E D  

Source: IADD (reprinted with permission) 
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3. Red or White Wine With Dinner? 

 So, you’re having a dinner party and you don’t know 
what kind of wine to serve with your main course. 

 Well the truth is, nowadays, you can serve whatever type 
of wine you like with whatever your course may be. The old 

adage of Red Wine with Red Meats, White Wine with White 
Meats is a bit passé in today’s society. Still, clichés exist for a 
reason, and the reason (in very basic terms), is this: 

 Red Wine: Because of the richer tannins and rolling fla-
vors found in red wine, the flavor and feel of le vin rouge 

tends to be more overpowering. When eaten with other rich 
flavors such as a creamy cheddar cheese or a juicy steak, the 

tannins in the wine ac-
tually bind to the pro-

teins in your food, 
thereby leaving your 
tongue less susceptible 

to the astringent, drying 
sensation that red wine often pro-

vides. Additionally, the rich flavors 
complement nicely with the strong, 

rich tastes found in your steak or 
cheese and the two work in har-
mony together. 

 White Wine: White wine 
tends to be crisper, lighter, higher 

in acidity but much lower in tan-
nins (if any). Because of this, white 

wine tends to go nicely with milder 
dishes such as poached seafood or 

raw oysters. The crisp, light flavors do not overpower the sub-
tle flavors of the food and provide a pleasant, refreshing ac-
companiment with them. 

 So which to choose? Really, any you like. While the above 
paragraphs demonstrate the reason behind the adage, there is 

no reason why you can’t try a rich, red wine with raw oysters 
or a crisp Chardonnay with you veal parmesan. In fact, I enjoy 

matching apparent opposites such as this. The flavors and con-
trasts are fun to experiment with. 
 Plus, if you’re like me, sometimes you just prefer a red 
over a white (or vice versa), no matter what you’re eating. 
 Bottom line? Red or White is really up to you and it is an 

acceptable practice in our modern age to drink whichever with 
whatever foods. In my experience, the folks that speak conde-

scendingly about “You’re supposed to drink red wine with 
that….” usually don’t know much about wine in the first place 
and are just spouting out what they’ve heard from everyone 
else. 
 So enjoy. And hey, at the bargain wine prices found in my 

reviews, you can try one of each! 
 

4. Removing Wine Stains 

 Employ these tactics at your own risk. 
 So, you’ve had a few friends over and you’re all sitting 
around the coffee table, having a good time. Someone gets up 

for another hit of your fabulous fondue and accidentally kicks 
the bottle of red wine that you put on the floor. Before you 

know it, it looks as though a homicide has been committed on 
your white rug and you’re dashing with ninja-like reflexes for 

the nearest towel. 

 1. Learning About Fruit Flavors in Wine 

 To discover the fruit flavors in your wine, you’ve got to 
know what the fruit tastes like. And unless you live in a place 

I’ve never heard of, you’re just not going to have all the fresh 
fruits available that are often nuanced in wine. Solution? Jam. 

Seriously: Go to your supermarket and get some jams. Black-
currant, plum, black cherry, strawberry and apricot are proba-
bly good ones to start with. I even found most of these at my 

local dollar store, so they only 
cost me a buck! And it really 

helps as you learn to taste the 
different flavors in wine. It’ll be 
handy at breakfast, too. 
 

2. Economical Sipping 
 I totally get it. You like wine, but even those $8.00 

bottles seem a bit much on the wallet sometimes. Well, 
this might be an obvious suggestion, but I’ve been amazed 
at the number of people who’ve never considered this 
before: 

 Have you checked out the prices on the big ol’ 1.5 
liter bottles at your wine store? (They’re called a 
“Magnum”) Often, you can find great deals on these, 
which are twice the amount of a regular bottle of wine and 
often go for $10.00-$12.00 or so. Some of my favorite red 

wines can be found at a better price in the Magnum bot-
tles since more and more companies are producing this 

option. If you store it well, it can keep for several days and 
keep you and your guests sippin’ in style! 
 Also, try the wine sales rack at the store–you can some-
times score some good deals and it will give you an opportuni-
ty to try a wine that you might not otherwise be able to afford. 

Or shop online if your state allows shipping. 
 Finally, if you are having a party and want some tasty 

wine but can’t afford the cost, check out the box wine section 
of your store. Yep, you heard me. Just like the Magnum bot-

tles, more and more companies are producing some tasty stuff 
in boxes. Now, don’t just buy any box wine–some of them 
really are not so great. But lots of newer versions are coming 

out with some pretty good vino and you might be able to score 
something you enjoy in a 750 ml bottle for a fraction of the 

price. In fact, I received a recommendation for “Black Box” 
box wine from a very nice antiwinesnob reader just recently. I 

have not tried it yet, but I’ll be sure to post a review when I do. 
If you try it, let me know what you think, okay? Just send it to 

jesse@antiwinesnob.com 
 If you do decide to buy boxed wine and are concerned 
about presentation, just empty the wine into some glass de-

canters or carafes for self-service. I bet your guests won’t know 
the difference. 
CAVEAT: IN AN EFFORT TO BE AS NON-SNOBBY AND OPEN MINDED AS POSSIBLE ABOUT 

BARGAIN WINE, I’VE ACTUALLY TRIED SOME OF THE WINE FROM THOSE BIG JUGS WITH 

SCREW CAPS THAT ARE OFTEN LOCATED AT THE BOTTOM RACK OF YOUR LIQUOR STORE. 

THERE MAY BE AN EXCEPTION THAT I’M NOT AWARE OF, BUT, GENERALLY SPEAKING, 

UNLESS YOU WANT AN UNPLEASANT EXPERIENCE FOLLOWED BY A SOUR STOMACH, STAY 

AWAY FROM THESE! 

Wine Tips & Tricks 

Cont. pg. 9 
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 What to do? 

 Windex. 
 I’m serious. This stuff is amazing. After dabbing up the 
wine as quickly as possible, spray Windex all over the stain and 
dab again with a clean towel (don’t use anything where the 
colors in the towel might rub off). Do all of this as quickly as 
possible and repeat. Chances are, you can minimize the stain or 
even make it disappear. 

 Voila! Red stain is banished. Plus, you might have im-
pressed your friends a little. 

 Two other home remedies I’ve heard of are Oxiclean or 
salt and water. I’ve not tried either of these, but I have used 
Oxiclean for other stains and have been pleased with its per-
formance. If you experiment with the salt-and-water remedy, 

make sure you use room temperature water as hot water can 

set the proteins in the stain and make it very difficult to re-
move. Let me know how it turns out, too. 

(jesse@antiwinesnob.com) 
 

5. More Clever Clues to Come 

Keep checking with antiwinesnob! 

Source: http://antiwinesnob.com/wine-reviews/ 

Didn’t receive a Directory? 

Listing incorrect?  

We want to hear about it! 

The 2016 ILICA Directory just went out last 

month. Now is a great time 

to sit down with the 

publication to review your 

listing for accuracy and 

check out our Associate 

listings. If you find an error 

in your listing or did not 

receive your Directory yet, 

be sure to give us a call in 

the office so we can update 

our records or get you another copy mailed out. 

 Finalized in July 2015, Illinois’s Nutrient Loss Reduction 

Strategy is now in the process of implementation. With interim 

nutrient reduction goals of 15% nitrogen and 25% phosphorus 

by 2025, the NLRS sets the bar for an eventual goal of 45% 

reduction of N and P loading for the state over time. Such an 

undertaking will require unique collaboration, cooperation, and 

implementation of nutrient reduction practices and manage-

ment activities from all contributing areas of the state- urban, 

agricultural, and industrial. 

 Agriculture is labeled as the primary contributor of non-

point source nitrate losses in the state, while industry ties agri-

culture for the top contributor title as it pertains to phospho-

rus. Thus, agriculture is receiving a lion’s share of the educa-

tion and implementation efforts that accompany the NLRS. 

With well over half a dozen various working groups, formed 

either within or out of the NLRS, there are numerous agencies, 

organizations, companies, and interest groups investing man-

power, time, funds and other resources to help IL meet its 

goals; much of these groups’ focus lies in farmer outreach, best 

management practice implementation, on-the-ground funding 

of projects, the provision of technical assistance, and the 

showcasing of these efforts. 

 ILICA realizes we play a critical role during these chang-

ing times, and we are doing our part 

to help IL reach our nutrient loss 

reduction goals in many ways. ILI-

CA sits on many of these NLRS 

working groups including the AWQPF, Alphabet Soup, NRCS 

State Tech Committee and NRCS NLRS sub-committee to 

name a few. We are involved with many partners and projects 

that directly impact NLRS goals such as IL Corn, The Wet-

lands Initiative, Farm Bureau and others. And we are on the 

front lines working with producers on a daily basis to address a 

variety of resource concerns and goals; many of these focused 

on or designed around water quality. 

 While the NLRS is new to everyone and while some un-

certainty exists surrounding how IL will achieve its nutrient 

reduction goals with no new NLRS funding nor State budget 

(at time of print), ILICA is poised to be a significant leader in 

this effort. We have the experience to guide new practice de-

sign and installation; we have the opportunity to diversify and 

expand our Association’s expertise to other forms of manage-

ment and practice implementation; and we have the responsi-

bility of directly educating our customers on new practices and 

products that will collectively help us all in Illinois improve 

water quality and meet our goals. 

I L L I N O I S ’ S  N U T R I E N T  L O S S  R E D U C T I O N  

S T R A T E G Y  (NLRS) D R I V E S  W O R K I N G  

G RO U P S ,  ILICA I N VO LV E M E N T  



 

 

 

July  -  August  2016  Page 10  

ATTENTION  

ILICA Associate Members 
 

With all the potential building projects on ILICA’s horizon, 
it only seems fair to keep our very generous associate 

members in the know.   

The most immediate opportunities will be the Wetland 
Project in Bureau Co. the 4th week in August and even 

though a specific site has not been selected, the Illinois 
Corn Growers field lab project will most likely be in the 

Champaign/Urbana area. The committee is hoping to get 
things determined in time for late summer as well.  

With multiple opportunities for equipment and/or material 

donations on these projects, the ILICA Leadership wants 
to assure our associate membership that they DO NOT 

expect everyone to donate at every opportunity.   

If you are interested in participating in one or both of 
these building projects or would like more detail about 

the construction itself, please contact Ryan at the ILICA 

office at (309) 446-3700 or via email at Ryan@illica.net.   

Support OUR Associates 

They Support US! 
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A Procedure for Thinning and Extracting Elevation Data from 
LiDAR Maps 

 In the previous issue of the LICA newsletter a comparison of contour maps derived from LiDAR data and from field 
surveys was presented. Subsequently, contractors have expressed interest in obtaining elevation data from contour 
maps. Such a procedure is presented in his article. The procedure may also be accessed online at 
http://www.wq.illinois.edu/dg/Extraction/LiDAR_Extraction_Procedure.htm 

The online version includes videos of each step of the procedure.   
 

 The procedure is designed for QGIS (http://qgis.org/en/site/), a public-domain GIS that is free, easy to use, and 
available for Windows, Mac, and Android computers. It also has the ability to convert maps between coordinate refer-
ence systems on the fly. Thus a map created in latitude/longitude coordinates can readily be displayed in State Plane 
coordinates. Other GIS programs can be used, if one is more familiar with those.  

 

Create Boundary File.  Use the polygon tool in Google Earth to create an outline of the field, and save it as a .kml file. The 
Google Earth default is to save it as a .kmz file, but this type of file cannot be opened in the GIS program.  Field 
outlines obtained from other sources can also be used.  

 
 

Load and Convert Boundary File. Open QGIS and load the .kml file.  (Layer ->Add Layer ->Add Vector Layer) Save it as a 
shape file in Illinois State Plane East or Illinois State Plane West coordinate reference system (CRS), depending on 
the county in which the field is located (Figure 2).  If this is the first time that a particular CRS is being specified on 
your computer, it will not be listed in the drop down box. In this instance it can be selected by clicking on the globe 
icon to the right of the dropdown box (Figure 3) and typing the name of the CRS.  Set the project CRS to that of the 
shape file. 

Source: University of Illinois Extension 

Figure 1. Outline of field in Google Earth 

http://qgis.org/en/site/
file://///abe-research.illinois.edu/www-wq/DG/Extraction/01_Creating_kml_File.webm
file://///abe-research.illinois.edu/www-wq/DG/Extraction/02_Loading_Boundary_File.webm
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A Procedure for Thinning and Extracting Elevation Data from 
LiDAR Maps (cont.) 

 

Load County LiDAR File. Load the county LiDAR file. (Layer ->Add Layer -
>Add Raster Layer) It is important that the field boundary be loaded before 
loading the county LiDAR file. County files are quite large and if they are 
loaded first, the entire file is loaded, and that takes quite a bit of time. If 
the field boundary is loaded first, and the screen zoomed to the field level, 
only the portion of the county file that will show up on the screen is load-
ed, saving time. County LiDAR files can be downloaded from the Illinois 
Geospatial Data Clearinghouse. 
(https://clearinghouse.isgs.illinois.edu/data/elevation/illinois-height-
modernization-ilhmp-lidar-data)   The required files are in the Digital Ter-
rain Model (DTM) subdirectory in the Derivatives folder. Thus, only the 
Derivates folder needs to be downloaded and expanded 
 

Extract a Section of the County LiDAR File. Save the county LiDAR data to a 
file that is limited to the extent of the screen. This step produces a LiDAR 
file that is much easier to manipulate than the county file. The data is at 
the same resolution as the county file.   
 

Clip LiDAR file to Field Boundary. Clip the file produced in Step 4 to the 
boundary of the field.  (Raster->Extraction ->Clipper)  The resolution can be 
changed at this stage.  
 

 

 

 

 

 

 

Convert to xyz Format. Convert the LiDAR file to xyz 
format.   (Raster ->Conversion ->Translate). A 
rectangular region is produced, with the eleva-
tion of points outside boundary being set to an 
extremely high negative number. In the next 
step, these external points are removed. 

 

Clean and Label xyz File. Unload the xyz file from 
QGIS. Open it in Excel, convert text to columns, 
sort the rows and remove external points. This 
step produces xyz points for the field, similar to 
those produced from a field survey.  

 

Load xyz file to QGIS. The xyz file can be reloaded 
into QGIS and processed in a similar manner to 
regular survey. .  (Layer ->Add Layer ->Add De-
limited Text Layer) 

 

I would like to thank Mark Baker from Springfield Plastics for working through the procedure and suggesting improve-
ments. His suggestions have been incorporated into this version of the procedure.  

Figure 2. Illinois State Plane Zones 

Figure 3. Icon for specifying a coordinate reference system (CRS) not already 
in drop down box 

file://///abe-research.illinois.edu/www-wq/DG/Extraction/03_Loading_County_LiDAR_Data.webm
https://clearinghouse.isgs.illinois.edu/data/elevation/illinois-height-modernization-ilhmp-lidar-data
https://clearinghouse.isgs.illinois.edu/data/elevation/illinois-height-modernization-ilhmp-lidar-data
file://///abe-research.illinois.edu/www-wq/DG/Extraction/04_Clipping_County_LiDAR_Map.webm
file://///abe-research.illinois.edu/www-wq/DG/Extraction/05_Clipping_to_Field_Boundary.webm
file://///abe-research.illinois.edu/www-wq/DG/Extraction/06_Extracting_xyz_from_LiDAR.webm
file://///abe-research.illinois.edu/www-wq/DG/Extraction/07_Cleaning_and_Labeling_xyz_file.webm
file://///abe-research.illinois.edu/www-wq/DG/Extraction/08_Adding_xyz_points_to_map.webm
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 The following Saturday morning, Birkey’s had several pieces 

of Case equipment including skid loaders, backhoes, dozers, and a 

mini excavator set 

up behind Bill 

Dean’s shop for 

display and a hands 

on Backhoe Rodeo.  

Everyone had a 

blast competing 

against each other 

by operating the various pieces of 

equipment through timed obstacle 

courses. Jon Seevers took home 

the Rodeo Champ title, while 

John McCoy was close behind in 

second place and Brian Brooks in 

third. Bower’s Great Lakes Inter-

Drain, Inc. sponsored a delicious 

breakfast before the event grilled by 

Bill Dean and Mid America Trenchers, LLC sponsored a grilled 

lunch before the member meeting.  

 Our heartfelt thanks go out to 

the Deans for their hard work and 

dedication to preparing and hosting 

this 2 day event. Thank you again 

to all our Area 6 golf outing spon-

sors at all levels and Birkey’s for 

their generosity in providing the 

equipment and manpower for the hands-on Backhoe Rodeo on 

Saturday morning.  ILICA events would not be as success as they 

are without the hard 

work and generosity of 

all those involved. So if 

you have a chance to 

thank any of these fine 

folks, please let them 

know that YOU appreci-

ate their efforts as well!  

Thanks, too, to 

everyone who 

attended or 

supported these 

events in every 

way! 

           The 5th Annual Area 6 Golf Outing was a huge suc-

cess with Mother Nature’s cooperation this year!  Sponsoring 

the outing this year was Jim 

Hawk Truck Trailers, Inc.; 

Altorfer, Inc.; Port Industries, 

Inc.; Springfield Plastics, Inc. 

and Birkey’s along with over 30  

different hole sponsors.  Fifty sev-

en golfers enjoyed Meadowview 

Golf Course’s beautiful links and 

delicious 

l u n c h 

and din-

ner menu, spon-

sored by H & S 

Company, Inc. & 

Hickenbottom, 

Inc., respectively. While the weather was 

“steamy” at times, it was perfect compared 

to the last couple of years’ outings in Mattoon.  

 Our sincere 

thanks to every-

one who sup-

ported the out-

ing including 

sponsors, do-

nors, volunteers, 

and golfers .  

This fundraiser helps ILICA keep growing in membership 

and activities, and it’s a great time to boot! There were only 

positive comments about the condition of the course, food & 

beverages, and 

the camaraderie 

on-hand during 

the event. A few 

comments were 

a little less posi-

tive regarding 

the results of 

i n d i v i d u a l 

play...but everyone still enjoyed the day!   

 Award winners for the day included: Longest Drive - 

Tyson Harris; Closest to the Pin - Steve  Karolewicz; Longest 

Putt - Pat McCabe; Lowest Scoring Team - Grant Curtis, 

Mark Baker, Kyle Kucurek, Mark Shortz; Most Honest Team 

- Corky Hopper, Cy Hopper, Bob McCallister, Stan Uphoff.  

A R E A  6  G O L F  OU T I N G ,  ILICA S U M M E R  P I C N I C  & 

M E M B E R  ME E T I N G  A R E  A  B I G  H I T !  
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Roger Bragg 

217-259-1996 

 See us for your farm, commercial 
and industrial needs.   

We carry a full line of Shell Rotella 

and Pro Performance products. 

Rick Bennett 

217-246-5162 

Office: 

217-728-7195 

A R E A  6  G O L F  OU T I N G ,  ILICA S U M M E R  P I C N I C  & 

M E M B E R  ME E T I N G  A R E  A  B I G  H I T !  ( C O N T . )  
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CALENDAR OF EVENTS 
 

Illinois 

Summer Drainage Workshop 

August 2 - 4th, 2016 

Richland Community College 

Shilling Center-Salon I & II 

One College Park, Decatur, IL 62521 
 

Board of Directors Meeting  

Saturday, September 10, 2016  

ILICA Office 

118 E. Knoxville St., Brimfield, IL 61517 

Committee meetings - 10 am - 1 pm 

Board Meeting - 2 pm 

 

National 

LICA Summer Convention 

InterContinental Kansas City at the Plaza 

401 Ward Parkway, Kansas City, MO 

July 19 - 23, 2016  

Hotel Block available Now! 

 

ADVERTISERS INDEX 
 

Advanced Drainage Systems, Inc. . . . . . . . . . . .  

Agri Drain Corp . . . . . . . . . . . . . . . . . . . . . . . . .  

BM Truck Equipment, Inc. . . . . . . . . . . . . . . . . 

Bower’s Great Lakes Inter-Drain, Inc. . . . . . . .   

BRON . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

Brown Bear Corp . . . . . . . . . . . . . . . . . . . . . . . . 

E-K Petroleum, LLC . . . . . . . . . . . . . . . . . . . . . 

Envision Insurance Group, LLC. . . . . . . . . . . .  

Fratco, Inc. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

JCG Midwest Drainage Products. . . . . . . . . . . .  

Jim Hawk Truck Trailers, Inc. . . . . . . . . . . . . . .  

Martin Equipment of Illinois, Inc . . . . . . . . . . . 

Metal Culverts, Inc . . . . . . . . . . . . . . . . . . . . . . .  

Mid America Trenchers, LLC . . . . . . . . . . . . . . 

Midwest Plastic Products . . . . . . . . . . . . . . . . . .  

Mike Cooks’ Soil & Water Mgmt. Systems . . . .   

Northland Trenching Equipment, LLC . . . . . . 

Precision Intakes Ltd  . . . . . . . . . . . . . .  

Prins Insurance, Inc./United Fire Group . .  

Prinsco, Inc . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

Roland Machinery Co. . . . . . . . . . . . . . . . . . . . . 

Schlatter’s, Inc. . . . . . . . . . . . . . . . . . . . . . . . . . .  

Springfield Plastics, Inc. . . . . . . . . . . . . . . . . . . .  

Vermeer Midwest, Inc . . . . . . . . . . . . . . . . . . . .  
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By-Laws Amended at Member Meeting 
 

By unanimous vote at the summer member meet-

ing in Mattoon on June 25, 2016, the ILICA by-laws 

were amended as proposed and printed in the last 

newsletter. The amended by-laws essentially rec-

ognize the utilization of electronic media such as 

email, conference calls, and skype for conducting 

ILICA business and meetings. 
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Check out http://www.licanational.com/ for more session and tour details 
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W O R K I N G  I N  T H E  S U M M E R  HE A T  

       Heat-related ill-

nesses can be deadly.  
Thousands become 

sick every year and 
many die due to pre-

ventable heat-related 
illnesses.  With sum-
mer temperatures 

rising, now is the best 
time to prepare for 

working outdoors in 

excessive heat by following a few simple steps 
 

HEAT-RELATED ILLNESS: KNOW THE SIGNS 

It's important to know the signs of heat-related illness—acting 

quickly can prevent more serious medical conditions and may 

even save lives. 
 

Heat Stroke is the most serious heat-related illness and re-
quires immediate medical attention. Symptoms include: confu-
sion, fainting, seizures, very high body temperature and hot, dry 

skin or profuse sweating. CALL 911 if a coworker shows signs 

of heat stroke. 
 

Heat Exhaustion is also a serious illness. Symptoms include: 
headache, nausea, dizziness, weakness, thirst and heavy sweat-
ing. Heat fatigue, and heat rash are less serious, but they are 

still signs of too much heat exposure. 
 

If you or a coworker has symptoms of heat-related illness, tell 

your supervisor right away. If you can, move the person to a 

shaded area loosen his/her clothing, give him/her water (a little 

at a time), and cool him/her down with ice packs or cool water. 

TO PREVENT HEAT ILLNESS:  

WATER.REST.SHADE.  

Drink water every 15 minutes, even if you are not thirsty. 

Rest in the shade to cool down. 

Wear a hat and light-colored clothing. 

Learn the signs of heat illness and what to do in an emergency. 

Keep an eye on fellow workers. 

Acclimate – "easy does it" on your first days of work; be sure to get 
used to the heat and allow yourself to build up a tolerance. Not 

being used to the heat is a big problem.  Many of the people 
who died from heat stress were either new to working in the 

heat or returning from a break.  
If a worker has not worked in 

hot weather for a week or more, 

their body needs time to adjust. 
 

This is OSHA’s fourth year im-
plementing its Heat-Illness Pre-
vention Campaign.  More re-

sources are available on OSHA’s 
website in English and Spanish 

and even an app to download to 
your phone to calculate the heat index and provide recommen-

dations based on your risk level.  Check out 
www.osha.gov/heat for training and other educational re-

sources.  
 

If you have questions, call OSHA.  It's confidential.  Call 1-800-

321-OSHA (6742) or visit www.osha.gov to learn more about 

your rights and staying healthy in the workplace.  

C O N T R A C T O R  

C L A S S I F I E D S  

FOR SALE 

Speicher 7060 Tile Machine: 

Hydrolic traction drive, new hydrolic 

wench, 6ft digging depth, original 

laser equipment 

Call: (309) 335-3043 

FOR SALE 

4' Laser Plane Digital Laser Mast.: 

Model# EM2E-12.   
 

Laser Plane Spectra Physics Digital 

Control Box: Model# CB2ETD.  
 

Spectra Precision Laser Receiver: 

Model#  R2S-S  
 

$2700.00 Will deliver 50+ miles or 

buyer pays shipping 
 

 Call or text (815) 791-2289  
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